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Painless CD/DVD Authoring.
Have you ever felt that although Mac OS X's built-in
disc authoring is nice, it is
at times rather limiting?
Have you ever wondered
what to do when a client
requested a custom hybrid
CD that required all the
Mac-specific files to be
hidden on the disc when
viewed on a Windows PC?
Enter shadowBurn, the only
painless CD/DVD authoring solution that is as
straightforward as anything
on Mac OS X.
shadowBurn is a CD/DVD authoring solution
for Mac OS X 10.4 and later that uses
Apple's powerful DiscBurning APIs to ensure
all disc authoring functionality provided by
your system are handled perfectly and adds
such much sought-after features like custom
hybrid disc creation and disc overburning
support for projects that just might fit on a
disc, even though the official disc size does
not allow the project to fit on it.

The power of shadowBurn lies in its simplicity
and straightforwardness. Easily accessible
when placed in the Dock, shadowBurn allows you to drag and drop items you want
to burn onto its icon or the project window
once shadowBurn is open. You can even
optionally install the shadowBurn Finder
plug-in which allows you to add items to
your burn project from the Finder's contextual menu, this way you don't even have to
keep shadowBurn in the Dock. This can be
useful when your Dock is already overcrowded with valuable applications in the
first place or your screen is too small and
you would like to keep your Dock nice and
clean.
shadowBurn supports virtual filesystems,
meaning you can create your disc layout the
way you want it, you don't have to arrange
your files in the Finder prior to burning them.
Just drag and drop them into the shadowBurn project window there you can set up
new folders to place the files in, and you can
even rename the files and folders in the
project window without worrying about
name differences in the Finder. shadowBurn
automatically handles this for you. Files and
folders can be moved around in the project
and grouped in all possible ways. When you
have the layout you desired ready, simply
push the Burn button, choose your disc
burner and your burn speed and let shadowBurn do what it does best: author your
disc for you.

shadowBurn needs absolutely no configuration to run, but it can be customized to better suit your needs. The preferences offers
settings to disable project size warnings and
set the default project type (CD/DVD) and
the respective project sizes.
shadowBurn supports multiple disc burners,
so if you want to burn your first project on
your fast CD burner and the second on your
great Superdrive, there's nothing that can
stop you. Simply set up your project, push
the Burn button and select the burner you
want to use from the pop-up button. It's that
easy.
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Troubleshooting
Why do my Burns Fail with Errors?
Burns can fail with errors if the media
that is being burned on has scratches
or fingerprints on its surface or is
otherwise damaged. If this is the
case, please try burning again on a
different disc. Should problems persist, please try using media from a
different vendor.
If you choose to overburn a disc and
the data will not fit on the media
(there is no way of determining this
before the burn starts) the burn might
fail with an error. If this is the case,
please try media from another vendor
or remove some files from your project so overburning the media is not
necessary.

Installation & Removal
Installing from the disk image
shadowBurn is distributed on a .dmg disk image file. To install it, simply mount the .dmg image
by double-clicking it in the Finder and copy the shadowBurn folder to your Applications folder
or any other desired location. Then simply double-click the shadowBurn application icon inside
the shadowBurn folder to start up shadowBurn.
shadowBurn comes factory set with optimal settings for the average user in an average environment, so you can start using it right away but you can always tailor it to your needs using
its Preferences.

Installing the shadowBurn Finder plug-in
The optional shadowBurn Finder plug-in is located inside Extras folder of the shadowBurn
folder. To install it, copy the shadowBurn Finder plug-in.plugin file to ~/Library/Contextual
Menu Items/. You will need to log out of the Finder and back in again to use the shadowBurn
Finder plug-in from the Finder’s contextual menu.

Full removal
To remove shadowBurn from your system simply delete the shadowBurn folder from your hard
drive and remove the com.stupidfish23.shadowburn.plist file from the Preferences folder
located inside the Library folder of your Home folder.

Should none of the above be the
case, try burning your disc with other
data burning applications, like the
built-in disc burner in Mac OS X's
Finder. Should that also produce
failed burns, the burner might be
damaged, please consult you're
drive's manufacturer.
Why are my Discs Labeled 'Untitled
Disc'?
If you do not set a title for your disc,
the resulting disc will be titled 'Untitled
Disc'. shadowBurn presents you with a
warning sheet should you try to burn
a disc without a title set.
Should you change the disc title and
still produce discs titled 'Untitled Disc',
please send an email to
shadowburn@stupidfish23.com and
explain your problem in greater detail
(what system you are using, which
shadowBurn version, etc.).

If you have the shadowBurn Finder plug-in installed, please remove it from ~/Library/
Contextual Menu Items/.

Also from stupidFish23

Quick Start
What is shadowBurn?
shadowBurn is a CD/DVD authoring solution for Mac OS X 10.4 and later that uses Apple's
powerful DiscBurning APIs to ensure all disc authoring functionality provided by your system
are handled perfectly and adds such much sought-after features like custom hybrid disc creation and disc overburning support for projects that just might fit on a disc, even though the
official disc size does not allow the project to fit on it.
shadowBurn offers a real alternative to Mac OS X's built-in disc authoring support and can be
a good choice if you do not need the extra functions more expensive solutions offer and thus
do not require the added price. shadowBurn is a lightweight and simple disc authoring solution for the rest of us.
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DesktopMagik is the next step in the
evolution of the desktop. Featuring
user customizable settings for displaying images, movies or websites on
your desktop,
DesktopMagik
provides a
unique desktop
experience that
must be seen to
be believed.
http://www.stupidfish23.com/desktopmagik

How does shadowBurn work?
shadowBurn uses Apple’s powerful DiscBurning APIs, which means that all CD/DVD burners
that are supported by Mac OS X are also supported by shadowBurn. It also means that all
media and burn speeds supported by Mac OS X are also supported in shadowBurn. But
shadowBurn adds a number of features that Mac OS X lacks, such as overburning support
and customizable Mac and PC hybrid disc content.

Which media type?
Which media type you choose (CD or DVD) is ultimately up to you. The media type only tries
to visualize the size of the project for you so you can quickly see how much free space there
is still left on the media you want to burn to. But the media type is not binding. If you are
working on a CD project, you can still decide to burn the project to a DVD if you so choose.
Deciding which media type you choose is your decision.

Which project type?
Which project type you choose (Mac Only, PC, ISO9660, UDF, Mac & PC Hybrid, MP3 or
Custom) is ultimately up to you. But here are a few things you might want to consider.
Mac Only (HFS+) discs contain data that can only be read on Macintosh computers. If you
want to burn discs that you'll never need to read on any platform, this is a good choice.
shadowBurn defaults to this project type for new projects.
PC (Joliet) discs contain data that can be read on both Macintosh and PC computers. But with
this option all Mac specific metadata, like Mac icons, Finder comments are not included on
the disc. If you want to burn discs to be used primarily on PCs, this is a good choice.
Mac and PC Hybrid discs contain data that can be read on both Macintosh and PC computers. With this option all Mac and Finder-specific metadata and PC related info are included on
the disc. If you want to burn discs that you want to able to read on any platform, this is a
good choice.
UDF is practically the successor of ISO 9660, supporting larger files, larger disk and more
information about individual files and folders. It includes support for special file properties,
such as Apple's File Types, resource forks, and other OS-specific data. It is mostly used for
DVD-Video discs. If you want to burn discs you want to play back on your standard desktop
DVD-player, this is a good choice.
ISO 9660, a standard published by the International Organization for Standardization, defines a file system for CD-ROM media. It aims at supporting different computer operating
systems such as Microsoft Windows, Mac OS, and systems that follow the Unix specification,
so that data may be exchanged. DVDs may also use the ISO 9660 file system (although the
UDF file system is far more commonly used). Names are restricted to upper case letters, digits
and underscores ("_"). If you want to burn discs that need to be compatible with older machines that use older operating systems, this is a good choice.
Some desktop CD and DVD players and some car stereos support the use of MP3 discs. MP3
discs are specially prepared discs with only MP3 files on them, often grouped into folders.
Some CD players even display the filenames of the MP3s to make navigation easier. If you
want to burn discs that you want to play in your supported car stereo, this is a good choice.
shadowBurn offers you the ability to create fully customizable discs. If you want to burn discs
that need to have special formats, the Custom Disc format is a good choice. With Custom
Discs you can specify exactly which filesystem data should be included on the Disc, you can
even create a disc with all four (HFS+, Joliet, ISO 9660 and UDF) filesystem representations.

Troubleshooting
Why can't I play my Discs on Windows PCs?
shadowBurn's default project settings
allow you to burn discs that are suitable to be used in macintosh computers only. The Mac only, or HFS+ option was chosen to be the default
project type because using it will produce a disc that contains all the necessary extra metadata that the Mac
OS X Finder uses to distinguish files,
like folder labels, Finder window
placement, etc. Discs burnt with this
option can not be played back on
Windows PCs, except with the help of
certain third party utilities that make it
possible to read HFS+ formated discs
on Windows PCs.
Why does shadowBurn ask me if I
want to Overburn my Disc?
Overburning in computer storage is
the process of recording data past the
normal size limit on a recordable
compact disc. If your Project size
exceeds the available free space on
the disc you are about to burn to by
not more than 20MB, shadowBurn
asks you if you want to still try and fit
the Project onto the inserted media.
Why does the Space Indicator turn
Orange and Red after some time?
The status bar below the file pane in
the main shadowBurn window displays how much space the files of the
project occupy approximately on an
empty disc. The color of the bar is
green. If the project's size is almost
the size of an average CD (in CD
Project mode) or DVD (in DVD Project
mode) the bar turns orange, if the
size is above the size of an average
CD (or DVD, depending on the active
Project type), the bar will turn red.

Also from stupidFish23
shadowGoogle offers fast and easy
web searches right from your desktop. A simple, unobtrusive, highly
customizable interface ensures that
you get your
searches done
the way they
should be
done.
Fast and
hassle-free.
http://www.stupidfish23.com/shadowgoogle
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Customizing shadowBurn

Troubleshooting

How to customize
shadowBurn is customizable through its Preferences. As shadowBurn prides itself with being
lightweight and straightforward, its customization features are not numerous. Here is a quick
list what you can change to make shadowBurn better work for you.

Customizable Features
! Project Size Warning
• Show warning when the Project is too big to fit on a CD
• Show warning when the Project is too big to fit on a DVD
! Default Project Media Sizes
• CD (650MB/700MB)
• DVD (4.3GB/8.6GB)
! Default Project Media Type
• CD Media
• DVD Media

Project Size Warning
shadowBurn prompts you to change your Project type from CD to DVD if the Project’s size is
bigger than what would normally fit on a standard CD disc. If you do not want shadowBurn to
prompt you with this question in the future, simply push the ‘Don’t ask me again’ button on the
sheet you are prompted with or uncheck the ‘Show warning when the Project is too big for a
CD’ checkbox of the Preferences window. You can of course always recheck the checkbox to
enable Project size checking again.
You can of course also enable/disable Project size warnings for the DVD Project type.

Setting default Project media sizes
Given the different sized media for both CDs (and CD-RWs) and DVDs (and DVD+/-RWs) the
Project size can not be set to a single value. By default the CD Project size is set to 700MB
and the DVD Project size is 4.3GB. If you however require these values to be changed to
650MB and 8.3GB (Dual Layer DVDs) respectively, you can change them in the Preferences
window. Already open Projects will of course reflect the changes made to the default Project
size instantly.

Setting default Project media types
shadowBurn allows you to set the default Project media type, that is the Project media type
that is automatically set up when you start up shadowBurn or start a new Project. The factory
default is CD, should you decide you actually burn more CDs than DVDs you can always
change this setting in the Preferences window.

Working with your Project

Why can't I Burn on a Rewritable
Disc?
Rewritable media, as its name applies
can be written to multiple times.
Unlike conventional Floppy disks, ZIP
disks or HDDs, CD-RWs and DVD-RWs
or DVD+RWs can only be written in
sessions, that means you can burn
your data on your discs, but if you
want to burn data on the same disc
you will need to erase its contents
first, then burn the new data on the
media (CD-RWs support multiple
sessions, where you can 'append' to
a disc while there is still free space
left, DVDs do not support multiple
sessions).
Why is the Burn Button Disabled?
The 'Burn' button is only enabled if
there is at least one file or folder
added to your project (even empty
folders count) and the a valid Project
type is selected (every Project type
from the Project popup button counts,
even the 'Custom...' one, if at least
one filesystem type is selected - like
HFS+ or Joliet).
Why are the Disc Format Buttons
Disabled?
The 'Disc Format' buttons are disabled
for every Project type except for the
'Custom...' one. The reason for this is
that the predefined Project types, like
Mac Only and ISO9660 have predefined formats which are not editable.
To create your own custom format
select 'Custom...' from the 'Project
Type' popup button.
Once the 'Custom... ' option is selected the Disc Format buttons are
accessible.

Single or Group?

Creating a new Burn Project
To burn Mac Only, PC (Joliet) or any other formatted discs with shadowBurn you first need to
set up a Project.
When you start up shadowBurn a default Project is automatically set up for you. The default
Project type is 'Mac Only (HFS+)' and the default Project media is a 700 MB CD.
To create a new Project, choose New Project from the File menu or press Command-N. A new
Project will always return to the default 'Mac Only (HFS+)' state. There can only be one Project active.
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Single User License"
$20.00
Do you own one Mac or want to
use shadowBurn on only one machine? In this case the Single User
License is right for you.
Group User License"
$50.00
Do you own multiple Macs at home
or work in an office environment with
lots of Macs connected via a local
network? In this case the Group
User License is right for you.
Can be used on up to 10 Macs.

Setting the Disc Title
To set the disc title for a given Project, simply enter a title into the 'Disc Title' field in the toolbar area of the Project window.
If you do not set the disc title prior to burning the Project to disc the default 'Untitled Disc' will
be used.

Creating Folders in your Project
To organize content in your Project you can create special so-called Virtual Folders. A Virtual
Folder is a folder that is not a physical one, i.e. one that is not available as a folder in the
Finder, rather it is only used to group files, real folders and other Virtual Folders in your Project into logical groups.
If you have a folder full of images for example and want to burn a disc of these images but
want to first split them into categories, like pictures of a birthday or a vacation, you can do so
by setting up Virtual Folders in your shadowBurn Project, leaving the original folder in the
Finder unchanged.
You can create a new Virtual Folder by pressing the 'Plus' button in the lower left corner of the
shadowBurn window.
Alternatively you can select the 'New Folder' item in the 'Project' menu or press CommandShift-N.
If you have a folder selected, the newly created Virtual Folder will be a child of the selected
folder. The newly created folder gets selected and the title will be selected so you can easily
give it a name. The default name for a new Virtual Folder is 'Untitled Folder'.

Adding Files/Folders to your Project
To add content to your Project you can use the 'Add to Project' item in the 'File' menu or press
Command-O. An Open Sheet will attach to the shadowBurn window where you can select
which Files and/or Folder you want to add to your Project. You can select multiple items as
well, shadowBurn will add all of them to your Project once you click the 'OK' button.
You can also select the files and folders you want to add to your Project in the Finder and
simply drag and drop them onto the shadowBurn window. They will automatically be added
to your Project.
You can even drag and drop the files and folders onto the shadowBurn icon in the Finder or in
your Dock. If shadowBurn is not running it will start up and set up a Project and add the
dropped items automatically. If it was running, the dropped items will be added to the active
Project.
If you have the shadowBurn Finder plug-in installed, you can use the Finder's contextual menu
to add selected items to your shadowBurn Project using the 'Burn with shadowBurn' option.
shadowBurn gets launched automatically and the selected items are added to the Project.

Troubleshooting
Why does my Disc Burn Slower than it
is Supposed to?
Recordable media comes with different supported burn speeds, most
prominently noted on the media's
packaging with text like '1x - 2x - 4x 8x Compatible'. This means, that the
given media is certified to be burnt at
the given speeds.
Of course this only applies if the
burner used to burn data on the media is capable of burning data at said
speeds. A 4x DVD burner can only
write to a DVD-R disc at a maximum
of 4x speed, but only if appropriate
media is used. If the disc to be burned
is only 1x - 2x certified, the drive will
only be able to burn it at the given
speed. If however the disc is certified
to be burned at up to 8x speed, the
disc will still only be burnt at a maximum of 4x speed, the maximum capability of the drive.
It is possible that both your drive and
the media officially support a given
burn speed, but actual burn speed is
lower than that. This is due to the fact
that the drive's firmware can switch
back the speed if it deems a certain
media to be unsafe at certain burning
speeds. There is nothing to be done
about this, save for trying the media
of another brand.
shadowBurn might report different
burning speeds throughout the period
of the burn. This is because shadowBurn always calculates the actual
burning speed at every given moment
and does not display the average
burning speed as do other burning
applications.

If you have a folder selected, the added items will be the children of the selected folder.

Renaming Files/Folders in your Project
You can burn discs that have files and folder whose names do not match with the files and
folders in the Finder from which they were created. shadowBurn supports so called Virtual
Filesystems, which basically mean you can manipulate your Project Data to represent the hierarchical filesystem you want to use on your disc and you do not even have to change anything in the Finder to the real files and folders.
You can only rename one file or folder at a
time. After selecting the item you want to
rename in the shadowBurn window select the
'Rename Selection' item from the 'Edit' menu
or hit Enter (Return). The item's name will
highlight and then you can start typing the
new name. Click anywhere in the shadowBurn
window or press Enter (Return) again to end
renaming the item.

Also from stupidFish23
shadowIP is the perfect solution for
a multinetworking environment with
constantly changing IP addresses.
A customizable interface, unobtrusive
live multiple IP
address monitoring add that little
extra you've
come to expect
from a stupidFish
product.
http://www.stupidfish23.com/shadowip
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You can also doubleclick on an item to edit its name or use the contextual menu on a selected
item by Control-clicking or Right-clicking and selecting 'Rename Selection'. The Contextual
menu can also be activated by pushing the Action button, the second button from left in the
lower left corner of the shadowBurn window.

Removing Files/Folders from your Project
You can remove multiple files and folders at a time. After selecting the items you want to remove in the shadowBurn window select the 'Remove Selection' item from the 'Edit' menu or hit
Backspace. The selected items will be removed automatically.
You can also use the contextual menu on selected items by Control-clicking or Right-clicking
and selecting 'Remove Selection'. The Contextual menu can also be activated by pushing the
Action button, the second button from left in the lower left corner of the shadowBurn window.

Changing the Disc Format
Creating a 'Mac Only' Disc
Mac Only (HFS+) discs contain data that can only be read on Macintosh computers. If you
want to burn discs that you'll never need to read on any platform, this is a good choice.
shadowBurn defaults to this project type for new projects.
To switch to Mac Only project type, choose the 'Mac Only (HFS+)' item of the 'Project Type'
submenu of the Project menu. Or simply press Command-1.
Alternatively choose the 'Mac Only (HFS+)' option from the Project Type pop-up button from
the main shadowBurn window's toolbar.

Creating a 'PC' Disc
PC (Joliet) discs contain data that can be read on both Macintosh and PC computers. But with
this option all Mac specific metadata, like Mac icons, Finder comments are not included on
the disc. If you want to burn discs to be used primarily on PCs, this is a good choice.
To switch to PC (Joliet) project type, choose the 'PC (Joliet)' item of the 'Project Type' submenu
of the Project menu. Or simply press Command-2.
Alternatively choose the 'PC (Joliet)' option from the Project Type pop-up button from the main
shadowBurn window's toolbar.

Creating a 'Mac and PC Hybrid' Disc
Mac and PC Hybrid discs contain data that can be read on both Macintosh and PC computers. With this option all Mac and Finder-specific metadata and PC related info are included on
the disc. If you want to burn discs that you want to able to read on any platform, this is a
good choice.

Did you know?
Customizing 'Mac and
PC Hybrid' Project
Content
With shadowBurn you can author
discs for use on Macs, PCs or both
platforms, you can even customize
certain items on your disc to be visible
only on one platform. This way you
could create discs that show different
content based on the platform they
are viewed on.
To create a disc that is usable on both
platforms, select 'Mac and PC Hybrid'
from the Project Type pop-up button.
Macs and PCs display filenames differently sometimes, but shadowBurn
automatically converts filenames that
need a different representation on a
different platform to the right format.
To exclude a file or folder from a
given platform simply select it, then
choose the 'Visible on Mac
(Command-Shift-M)' or the 'Visible on
PC (Command-Shift-P)' item from the
'Edit' menu.
Alternatively you could use the action
button in the lower left corner of the
shadowBurn application window.
Items that show a checkmark in front
of a platform will be included on that
platform, files that don't have a
checkmark for a given platform will
not be included on that platform. It is
not possible to have files in your projects that are not visible on any platform.
You can only rename one file or
folder at a time.

For more information on how to customize Mac and PC Hybrid discs, see Customizing 'Mac
and PC Hybrid' Project Content (sidebar).
To switch to Mac and PC Hybrid project type, choose the 'Mac and PC Hybrid' item of the
'Project Type' submenu of the Project menu. Or simply press Command-3.
Alternatively choose the 'Mac and PC Hybrid' option from the Project Type pop-up button
from the main shadowBurn window's toolbar.

Creating a 'UDF' Disc
UDF is practically the successor of ISO 9660, supporting larger files, larger disk and more
information about individual files and folders. It includes support for special file properties,
such as Apple's File Types, resource forks, and other OS-specific data. It is mostly used for
DVD-Video discs. If you want to burn discs you want to play back on your standard desktop
DVD-player, this is a good choice.
To switch to UDF project type, choose the 'UDF' item of the 'Project Type' submenu of the Project menu. Or simply press Command-4.
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Also from stupidFish23
InsulinDiaryX is an application
designed to help those who have
Diabetes manage their lives
better. An easy
to use, highly
customizable
interface helps
to keep track
of valuable
health information.
http://www.stupidfish23.com/insulindiaryx

Alternatively choose the 'UDF' option from the Project Type pop-up button from the main
shadowBurn window's toolbar.

Creating an 'ISO 9660' Disc
ISO 9660, a standard published by the International Organization for Standardization, defines a file system for CD-ROM media. It aims at supporting different computer operating
systems such as Microsoft Windows, Mac OS, and systems that follow the Unix specification,
so that data may be exchanged. DVDs may also use the ISO 9660 file system (although the
UDF file system is far more commonly used). Names are restricted to upper case letters, digits
and underscores ("_"). If you want to burn discs that need to be compatible with older machines that use older operating systems, this is a good choice.
To switch to ISO 9660 project type, choose the 'ISO 9660' item of the 'Project Type' submenu
of the Project menu. Or simply press Command-5.
Alternatively choose the 'ISO 9660' option from the Project Type pop-up button from the main
shadowBurn window's toolbar.

Creating an 'MP3' Disc
Some desktop CD and DVD players and some car stereos support the use of MP3 discs. MP3
discs are specially prepared discs with only MP3 files on them, often grouped into folders.
Some CD players even display the filenames of the MP3s to make navigation easier. If you
want to burn discs that you want to play in your supported car stereo, this is a good choice.
To switch to MP3 Disc project type, choose the 'MP3 Disc' item of the 'Project Type' submenu
of the Project menu. Or simply press Command-6.
Alternatively choose the 'MP3 Disc' option from the Project Type pop-up button from the main
shadowBurn window's toolbar.
shadowBurn automatically prepares your content and only allows supported file types for the
MP3 disc format. If you choose to switch your project to an MP3 project, all files that are not
MP3 files or folders are removed from the project.

Creating a 'Custom Format' Disc
shadowBurn offers you the ability to create fully customizable discs. If you want to burn discs
that need to have special formats, the Custom Disc format is a good choice. With Custom
Discs you can specify exactly which filesystem data should be included on the Disc, you can
even create a disc with all four (HFS+, Joilet, ISO 9660 and UDF) filesystem representations.
To switch to Custom project type, choose the 'Custom...' item of the 'Project Type' submenu of
the Project menu. Or simply press Command-7.
Alternatively choose the 'Custom...' option from the Project Type pop-up button from the main
shadowBurn window's toolbar.

Did you know?
Hybrid content customization"
To create custom Mac and PC hybrid
discs, simply select the Mac & PC
Hybrid option from the Project Type
pop-up button. Then if you select a file
you can change its visibility on certain
systems. This way you can exclude
certain files from appearing on other
systems. This can be helpful if you
don't want any exe or other files to
appear when the disc is inserted into
a Mac or that Mac-specific data is
displayed on Windows PCs.
Future proof
shadowBurn was designed to be future proof. This required that shadowBurn is only available for Mac OS
X 10.4 (Tiger) and higher. But it also
means, that shadowBurn is also available on the yet to be announced first
Intel-based Macintosh computers.
shadowBurn is a so-called Universal
Binary, an application that can be run
on both the PPC-based Macintosh
computers and the Intel-based ones.
Burn from the Finder
The optional shadowBurn Finder plugin enables you to add files from the
Finder directly to your existing shadowBurn project or create one for you.
Just select the Burn with shadowBurn
option from the Finder's contextual
menu and the files show up in the
project.
The shadowBurn Finder plug-in is
easily installed or removed, but to
allow the changes to take effect, the
Finder needs to be logged out and
then back in. Alternatively you can
choose to reboot your system to take
advantage of the new feature.

Choosing a Project Media
shadowBurn supports a variety of media. You can choose to create CD or DVD projects.

Working on a CD Project
The most common CD size is approximately 700 MB, which is the default Project size setting
for shadowBurn CD Projects. You can change this value to 650 MB by selecting 'Preferences...' from the shadowBurn menu and setting the appropriate radio button.
The status bar below the file pane in the main shadowBurn window displays how much space
the files of the project occupy approximately on an empty disc. The color of the bar is green.
If the project's size is almost the size of an average CD the bar turns orange, if the size is
above the size of an average CD, the bar will turn red.
It might still be possible to burn your Project even if the bar turns red. The bar only represents
an average value. shadowBurn calculates the final size and compares it to available space on
the inserted disc before it starts a burn.
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Also from stupidFish23
shadowDisk offers on your desktop
what expensive disk monitoring
applications offer,
just without much
of the hassle
(or the price
tag). It is highly
customizable
and can be
tailored to suit
your exact needs.
http://www.stupidfish23.com/shadowdisk

If the size of your project exceeds the size of an average CD, shadowBurn will offer to
change the Project Type to DVD.

Working on a DVD Project
The most common DVD size is approximately 4.3 GB, which is the default Project size setting
for shadowBurn DVD Projects. You can change this value to 8.6 GB (Dual-Layer Discs) by
selecting 'Preferences...' from the shadowBurn menu and setting the appropriate radio button.
The status bar below the file pane in the main shadowBurn window displays how much space
the files of the project occupy approximately on an empty disc. The color of the bar is green.
If the project's size is almost the size of an average DVD the bar turns orange, if the size is
above the size of an average DVD, the bar will turn red.
It might still be possible to burn your Project even if the bar turns red. The bar only represents
an average value. shadowBurn calculates the final size and compares it to available space on
the inserted disc before it starts a burn.
If the size of your project exceeds the size of an average DVD, shadowBurn will warn you.
shadowBurn automatically prepares your project to the right format of the disc you inserted
(DVD-R, DVD+R, etc.).

Working with Recordable Media
There are a lot of different media types your drive can burn and even more that your drive
can play. shadowburn supports CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW and
DVD+R DL (Dual Layer) burning with supported drives.

Erasing a Rewritable Disc
Rewritable media, as its name applies can be written to multiple multiple times. Unlike conventional Floppy disks, ZIP disks or HDDs, CD-RWs and DVD-RWs or DVD+RWs can only be
written in sessions, that means you can burn your data on your discs, but if you want to burn
data on the same disc you will need to erase its contents first, then burn the new data on the
media (CD-RWs support multiple sessions, where you can 'append' to a disc while there is still
free space left, DVDs do not support multiple sessions).
To erase a rewritable disc simply insert it into your drive, and select the 'Erase Disc...' item
from the 'Disc' menu, or push the 'Erase' button in the toolbar. You can also use the CommandOption-Backspace hotkey combination.
A dialog sheet will be presented on the main shadowBurn window where you can choose
between Quickly (a few seconds) and Completely (up to half an hour). Push the 'Erase' button
and wait for the process to finish.
If you want to burn to a rewritable disc that already has some data on it, you can tell shadowBurn to erase the disc's contents before burning automatically.

Burning a Project to Disc
After creating a Burn Project, adding the data you want to burn and setting the disc format
all you need to do is insert the media you want to burn on into your drive and select the 'Burn
Disc...' item from the 'Disc' menu or push the 'Burn' button in the toolbar. Alternatively you can
use the Command-R shortcut.
A setup sheet will be presented on the main shadowBurn window, there you can choose different settings (burn speed, verification, etc.). To start the burn, push the 'Burn' button.

Getting Disc Information
shadowBurn can display some basic information on inserted media.
The main shadowBurn window's title always displays basic information on inserted discs, like
the type of the media (CD-R, DVD+RW, etc.), available maximum burn speed and available
free size in MB.
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Buying Information
How to buy shadowBurn
You can purchase shadowBurn from
the stupidFish programming online
store (http://store.stupidfish23.com).
You can pay via credit card (supported cards are VISA, MasterCard,
AmericanExpress and JCB).
How safe is my personal information?
stupidFish programming collects and
uses your personal information to give
you superior customer service, to
provide you with convenient access to
our products and services, and to
make a wider range available to you.
In addition, we use your personal
information to keep you up to date on
the latest product announcements,
software updates, special offers, and
other information we think you’d like
to hear about, if you choose so. From
time to time, we may also use your
personal information to contact you
to participate in a market research
survey, so that we can gauge customer satisfaction and develop better
products.
We collect information about you
when you order a stupidFish programming product online, or ask to
be included in an email mailing list,
the fishList, we collect and store the
information you provide in a secure
database.
stupidFish programming never discloses your personal information to a
third party. All information is used
exclusively for internal customer tracking and for fishList contacts.
#
At times we may be required by law
or legal process to disclose your personal information. We may also disclose information about you if we
believe that disclosure is necessary
for the public interest.
If you would like to review your personal information that stupidFish programming may have about you, email
us at privacy@stupidfish23.com.
stupidFish programming safeguards
the security of the data you send us
with physical, electronic, and managerial procedures. We urge you to
take every precaution to protect your
personal data when you are on the
Internet. Change your passwords
often and use a secure browser.

By selecting the 'Disc Info' item from the 'Disc' menu (Command-Option-I) an information sheet
gets presented on the main shadowBurn window. This info sheet makes it possible to get more
detailed info on discs inserted in any of the burners attached to your Mac. The Info sheet
presents you with data on available sessions (session number, starting block, session size),
available free space, erasability, disc format and available burn speeds.
The Disc Info sheet can only be presented if a disc is in the drive.

Overburning a Disc
Overburning in computer storage is the process of recording data past the normal size limit on
a recordable compact disc.
Many disc manufacturers extend a recordable disc to leave a small margin of extra groove at
the outer edge. This lead-out was originally intended to provide tolerance for the read head
of an audio CD player should it overseek, by providing a padding of up to 90 seconds of
silent digital audio.
Recording onto the lead-out is possible with some CD/DVD recorders and authoring software
like shadowBurn. The actual amount of data that it will hold depends ultimately on the recordable media and varies somewhat between brands of disc, with some being up to 10% of the
total disc capacity.
Almost all CD-ROM drives are capable of reading from the lead-out. For this reason, software
publishers have on occasion shipped their software on similarly oversized compact discs to
reduce packaging costs. Oversized discs have also been used as a form of copy protection
because it is more difficult to record copies of them.
shadowBurn allows overburning of up to 20 MB of data on your discs. If your project is bigger than the media you inserted by up to 20 MB, then shadowBurn will present you with a
dialog sheet before burning, asking you wether you would like to try and overburn the disc.
Overburning does not always work and might produce unreadable discs. Wether or not overburning is successful ultimately depends on the media and the burner used.
shadowBurn does not support overburning discs with oversized projects bigger than the inserted media + 20 MB.

Fixed & Known Bugs

Credits
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Engineering
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stupidFish programming
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Kemenczei Gábor
Dombovári András
Polyák Sándor
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Documentation
Salánki Benjámin
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shadowBurn 1.0 known bugs
• If multiple burners are present, changing the burner in the Burn Setup Panel might not
change the Disc Info presented on the Project window’s title bar.

For more information
This document contains information valid at the date of issue. For up to date information on stupidFish
programming and its products and services please visit the stupidFish23 homepage at www.stupidfish23.com.
For product and development related questions please visit the stupidFish23 forums at forum.stupidfish23.com
or send an email detailing your question to support@stupidfish23.com.
© 2002 – 2005 stupidFish programming. All rights reserved. stupidFish23, shadowBurn, shadowClipboard, shadowGoogle, shadowIP,
shadowDisk, DesktopMagik, InsulinDiaryX and the stupidFish logo (by Pete Joison) are trademarks of stupidFish programming. Apple,
Aqua, Mac, Macintosh, Mac OS, Mac OS X and Power Mac, are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries. Finder and Xcode are trademarks of Apple Computer, Inc. Other product and company names mentioned herein may be
trademarks of their respective companies. Product specifications are subject to change without notice. This material is provided for information purposes only; stupidFish programming assumes no liability related to its use.
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